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Galaxy, a web-based genome analysis platform

» is an open-source framework for integrating various
computational tools and databases into a cohesive
workspace.

» A web-based service we provide, integrating many popular
tools and resources for comparative genomics.

» A completely self-contained application for building your own
Galaxy style sites.




Galaxy Project Interface

- Galaxy

Data intensive biology for everyone.

Galaxy is an open, web-based platform for data intensive biomedical research.
Whether on the free public server or your own instance, you can perform,

reproduce, and share complete analyses.

Get Galaxy Learn Galaxy Get Involved

Use Galaxy

Advanced fastQ
manipulation

Galaxy 101, ... Mailing lists, Tool Shed, wiki

Use project's free server Install locally or in the cloud
- 3 Screencasts
or other public servers or get Galaxy on SlipStream

Search all resources

The Galaxy Team is a part of BX at Penn State, and the Biology and Mathematics and Computer

Science departments at Emory University. The Galaxy Project is supported in part by NHGRI, NSF,
The Huck Institutes of the Life Sciences, The Institute for CyberScience at Penn State, and Emory

University.

http://galaxyproject.org/




Galaxy analysis web interface

Galaxy

Analyze Data

o New high performance job execution options are available! See the wiki for more information.

Tools

search tools

Get Data

Lift-Over

Text Manipulation
Convert Formats
FASTA manipulation
Eilter and Sort

Join, Subtract and Group
Extract Features

Fetch Sequences
Eetch Alignments

Get Genomic Scores
Operate on Genomic Intervals
Statistics
Graph/Display Data
Regional Variation
Multiple regression
Multivariate Analysis
Evolution

Motif Tools

Multiple Alignments
Metagenomic analyses
Genome Diversity

NGS TOOLBOX BETA
Phenotype Association
NGS: QC and manipulation
NGS: Mapping

NGS: SAM Tools

NGS: GATK Tools (beta)
NGS: Peak Calling
NGS: RNA-seq

NGS: Picard (beta)
NGS: Variant Analysis
NGS: VCF Manipulation
snpEff

BEDTools

EMBOSS

History c%
Galaxy is an open source, web-based platform for data intensive biomedical research. If you are new to Galaxy start here or °
consult our help resources.
Unnamed history
0 bytes 4
Tweets ¥ Follow © This history is empty. You can
load vour own data or get data
- from an external source

Bjérn Griining
#usegalaxy based MUMmer @docker i image. Powered by

@pjacock wrappers! registry.hub.docker.com/u/bgruening/ga... B
3 Retwe

gruening 28 Nov

Galaxy Project

Expand

Bjérn Griining
help testing #usegalaxy the easy way: docker run -p 8080:80 -p
8800:8800 --privileged bgruening/galaxy-stable:dev
(@IPythonDev mcluded)

3 Retw

gruening

Expand

Community- drwen development for computational biology at

® @ Galaxy Project axyproject 27 Nov
@ Sprints, Hackathons & Codefests, Méller, et al. bit.ly/1zBliUx v

Tweet to @galaxyproject

= 7~ iPlant
PENNSTATE v TA@@ @) Collaborative

JOHNS HOPKINS

UNIVERSTTY

The Galaxy Team is a part of the Center for Comparative Genomics and Bicinformatics at This instance of Galaxy is utilizing infrastructure generously provided by the iPlant
Penn State, and the Department of Biology and at Johns Hopkins University. Collaborative at the Texas Advanced Computing Center, with support from the National

Science Foundation.

The Galaxy Project is supported in part by NSE, NHGRI, The Huck Institutes of the Life Sciences, The Institute for CyberScience at Penn State, and Johns Hopkins University.

This is a free, public, internet accessible resource. Data transfer and data storage are not encrypted. If there are restrictions on the way your research data can be stored and used, please consult your local
institutional review board or the project PI before uploading it to any public site, including this Galaxy server. If you have protected data, large data storage requirements, or short deadlines you are
encouraged to setup your own local Galaxy instance or run Galaxy on the cloud.

Galaxy af570 71 883¢76Fd1efcessdbTc

https://usegalaxy.org/
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Galaxy: the instant web-based tool and data resource
integration platform

» Open Source downloadable package that can be
deployed in individual labs

» Modularized
- Add new tools
> Integrate new data sources
> Easy to plug in your own components

» Straightforward to run your own private galaxy
server




Galaxy instance

-_ Galaxy

Tools

[ search tools

Get Data

Send Data

ENCODE Tools

Lift-Over

Text Manipulation

Filter and Sort

Join, Subtract and Group
Convert Formats

Extract Features

Fetch Sequences

Fetch Alignments

Get Genomic Scores
Operate on Genomic Intervals
Statistics

Wavelet Analysis
Graph/Display Data
Regional Variation
Multiple regression
Multivariate Analysis
Evolution

Motif Tools

Multiple Alignments
Metagenomic analyses
FASTA manipulation

NGS: QC and manipulation
NGS: Indel Analysis

NGS: RNA Analysis

NGS: SAM Tools

NGS: GATK Tools (beta)
NGS: Simulation
SNP/WGA: Data; Filters
SNP/WGA: QC; LD: Plots

https://galaxy.bioinfo.ucr.edu/root

Analyze Data

Institute for Integrative

Genome Biology

History - o
Unnamed history
0 bytes 74|

Welcome to IIGB's Galaxy Server!

Overview

Galaxy is an open, highly customizable, web-based platform for the analysis of next generation
sequence data and many other biological data types. It enables users to run computationally
demanding next generation sequencing analysis tasks on powerful server hardware from a
graphical web browser-based user interface rather than the Linux command-line. A subset of of
application supported by Galaxy is given in the left pane. Much more detailed descriptions of
Calaxy's basic functionalities including user tutorials are available here.

Why Local Galaxy Service?

There are many advantages of using a local Galaxy server here at UCR rather than public test
instances of Galaxy available on the internet. The most important are: (1) shorter waiting queues
for analysis tasks; (2) elimination of time consuming uploads of large data sets; (3) support for
analyzing much larger data sets than this is possible on public services; (4) the ability to
customize software tools and database collections.

How to Gain Access?

This instance of Galaxy runs on lIGB's high performance compute (HPC) infrastructure, called
Biocluster. As such its usage is covered by the annual registration fee for this infrastructure (see
here for details). Users with an active Biocluster account can access this Galaxy service using
their existing user name and password without any extra cost. New account requests for this
service can be sent to support@biocluster.ucr.edu.

Additional Databases and Sofware Tools
Support requests for including additional reference genomes and software tools on IIGB's Galaxy
server can be sent to support@biocluster.ucr.edu

Workshops on Galaxy
Past and future UCR workshop events on using Galaxy are listed here. The user manual from
previous workshops can be accessed here.

Enter IIGB's Galaxy Service
To enter this service, click here.

© Your history is empty. Click 'Get
Data’ on the left pane to start
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Galaxy - the one stop shop for Genome Analysis

» Analyze

- Retrieve data directly from popular data resources or upload your own.

> Interactively manipulate genomic data with a comprehensive and
expanding best-practices toolset.

- Galaxy is designed to work with many different datatypes. ( )

» Visualize

> Trackster is Galaxy’s visualization and visual analysis environment.
> See more details ( )

» Publish and Share

- Results and step-by-step analysis record (Data Libraries and Histories)
> Customizable pipelines (Workflows)

- Complete protocols (Pages)

11



Tools and Data Sources

» Data Sources

- Upload file from your computer
> UCSC table browser
- BioMart, modENCODE, GrameneMart, WormBase servers

» Tool Suites

Text manipulation

Join, Subtract and Group
Format converters

NGS

Graph plotting

Motif tools

o

(e]

(¢]

o

(¢]

o

12



Data Libraries

» Datasets are accessible from within Galaxy or for download.

Data Libraries

search dataset name, info, message, dbkey
Advanced Search

Data library name ! Data library description

1000 Genomes Data from the 1000 Genomes Project FTP site

AC-exome

Bushman Data for Nature Letter "Complete Khoisan and Bantu genomes from southern Africa"

ChIP-Seq Mouse Example Data used in examples that demonstrate analysis of ChIP-Seq data

Chobi

CloudMap Contains userguide, reference files, and configuration files for the Cloudmap WGS analysis pipeline

Codon Usage Frequencies

Coleman lonPCM
Denisovan sequences Files from 'A high-coverage genome sequence from an archaic Denisovan Individual® Meyer et al. Science 2012 and basic processed data.
Erythroid Epigenetic Landscape Dynamics of the epigenetic landscape during erythroid differentiation after GATAL restoration

Evolutionary Trajectories in a Phage ~ Experimental evolution (lllumina)

GATK
GCAT Consortium
Genome Diversity Nucleotide polymorphisms for several threatened species

guru 1000GP

He-2010

Heteroplasmy Data for Genome Biology 2011 manuscript
iGenomes Selected files from Illumina iGenomes collection
lllumina BodyMap 2.0 RNA-seq data for the lllumina BodyMap 2.0 project

lllumina iDEA Datasets

Sub-samapled versions of datasets used for the Illumina iDEA challenge
(sub-sampled)

Irish whole genome sequence and analysis

Irish whole genome




Workflows

» Workflows specify the steps in a process.

» Workflows are analysis that are meant to be run, each time
with different user-provided datasets.

Toals | Running workflow "Workflow constructed from history ((Expand all | cCollapse |
o) | 'SNPseq_Analysis_Galaxy_workshop2013™

Get Data Step 1: Input dataset

Send Data

ENCODE Tools Input Dataset

Lift-Over | 8: Filter FASTQ on data 3 5
Text Manipulation [type to fitte \

Filter and Sort

oin, Subtract and Group

Conven Eormate Step 2: Input dataset
Extract Features
Fetch Sequences

Fetch Alignments

Input Dataset

| 7: http://biocluster.ucr.edu/~nkatiyar/Galaxy_workshop/Snpseq/tair10chr.fas ?]

Get Genomic Scores itx pe to filte ‘
Operate on Genomic Intervals

Statstice Step 3: FASTQ Groomer (version 1.0.4)

Wavelet Analysis

e e Step 4: FASTQ Summary Statistics (version 1.0.0)

Regional Variation
Multiple regression

Rt Step 5: FastQC:Read QC (version 0.51)

Evolution Short read data from your current history
Motif Tools Output dataset 'output_file' from step 3
Mdiiple Aligniments Title for the output file - to remind you what the job was for
Metagenomic analyses FastQC
FASTA manipulation g 2
Contaminant list
NGS: OC and manipulation ST s ?]
NGS: Indel Analysis
NGS: RNA Analysis Step 6: Filter FASTQ (version 1.0.0)
NGS: SAM Tools
NGS: GATK Tools (beta) Step 7: Map with BWA for Illumina (version 1.2.3)
NGS: Peak Calling
S St Step 8: SAM-to-BAM (version 1.1.2)

SNP/WGA: Data; Filters
SNP/WGA: OC; LD: Plots
SNP/WGA: Statistical Models
Phenotype Association

Step 9: MPileup (version 0.0.1)

p 10: i i .0.
e ——— Step 10: beftools view (version 0.0.1)
Workflows ) Send results to a new history

= All workflows

Run workflow




Pages

» Pages are documentation within the Galaxy that explain the
steps and reasoning in a particular history or workflow.

Published Pages

Q
Advanced Search
Title Annotation Owner Community Rating Community Tags Last Updated;
Galaxy RNA-seq Analysis Exercise An exercise that illustrates how to use Galaxy for RNA-seq analyses. jeremy L 8 6 6 6 ¢ rna-seq | | tutorial | [ ra | | sl Nov 18, 2014
honevbee page associated with Fuller et al. (2014) webb Sep 28, 2014
Page describes data and workflows in Goecks et al.'s 2014 paper on integrated cancer genomics with 2
Cancer Analyses 0 pep 9 g jeremy Aug 21, 2014
Galaxy.
Raisins NGS Quality Control Using Galaxy: Training Day, GCC 2014 usinggalaxyd W R * Jul 02, 2014
NGS Analysis 2013 Supplemental Tutorials "MiMB: Analysis of Next-Generation Sequencing Data Using Galaxy” galaxyproject Jun 18, 2014
Extract Workflow Tutorial: Extract Workflow from a History galaxyproject May 13, 2014
Tutorial (Yodosha, 2014 kawaji May 08, 2014
3 . R Galaxy 101 NGS Tutorial: Heteroplasmy: Mother-Child mtDNA Variant Polymorphism Detection Step-by- s 7 3 7
Galaxy 101 NGS: Introduction to Polymorphism Detection via Variant Analysis Step galaxyproject W iy i ngs | [ variant | | tutorial | [ galaxy101 | | video Apr 30,2014
Controlling for Contamination in Resequencing Biotechniques 56(3) companion page aunl Mar 18, 2014
CloudMap A Cloud-based Pipeline for Analysis of Mutant Genome Sequences gm2123 Feb 08, 2014
inerger{t functior?s of hematopoietic transc.rig‘tion factors in lineage priming and paper companion site csm165 Jan 15, 2014
differentiation during ervthro-megakaryopoiesis
FinalProject.Fridland Elucidation of Conserved and Nonconserved Residues in MspA and Similar Portal Proteins sfridland Dec 15, 2013
Self-Binding GPCR Seach bnorgeot Dec 14, 2013
Screencast videos for usegalaxy.org UseGalaxy.org Screencast Videos at Vimeo galaxyproject Dec 03,2013
Supplemental information for "Using Galaxy to Perform Large-Scale Interactive Data Analysis” paper in . = = =
ing y ot 4 % I t hip- f | | tutorial t | Dec 03, 2013
Using Galaxy 2012 Current Protocols in Bioinformatics, unit 10.5 gelaxyprojed Wik Seoy) ) (e i e S
OianYuBioinformatics BioinformaticsProblemSet clark Nov 27,2013
This page contains datasets for the following paper: "Segmenting the human genome based on states of
iverg o " : Oct 23, 2013
ARidvergence states neutral genetic divergence” Proc Natl Acad Sci U S A.... Lk wkk ik 5
. . Trackster is Galaxy's integrated visual analysis environment. This page describes how Trackster was used to
Interactive RNA-seq with Trackster Jeremy 0 0 6.8 ¢ ¢ Sep 18, 2013

perform interactive RNA-seq using...
SNP classification SNP classification workflow and history for Mutation Detection 2013 Belinda Apr 19, 2013

data sets and workflows for the paper "High-throughput analysis of large and possibly unassembled

pipeline genomes” webb Mar 18, 2013
Sy data sets and workflows for the paper "Aye-aye population genomic analyses highlight an important center webb AR Mar 17, 2013

of endemism in northern Madagascar” (PNAS)

. -



History

» Histories are all steps in the process and the used setting.

» Histories can be imported into your session and rerun as it is
or modified.

alyze Data Using 0%
Tools Histo o= i
HISTORY LISTS
" import and start using history [ refresh | show deleted [ collapse all f
[ search tools Q) F ! ! ! RNA!  aved Histories
) , sis Galaxy w 2 op_2
e RNASeq_Analysis_Galaxy_workshop_2013 P. Cicionas Shared Wikt
e 140 o
Send Data 1: http:/ /biocluster.ucr.edu/~nkatiyar/Galaxy workshop/Rnaseq/SRR064154.fastg @ B TORY
ENCODE Tools 215.4 MB 39: ¢ Create New
Lift-Over format: fastq, database: 2 data  c5py History
i i tos Ll Copy Datasets
Text Manipulation uploaded fastq file py
Filter and Sort =® 38: C Share or Publish
Join, Subtract and Group df‘#— Extract Workflow
Convert Formats @SRRO64154.208 HWUSI-EAS627_1:8:1:2:1681 length=38 diffe) Dataset Security
Extract Features ANGANNNGGACTTTGANAAGAGAGTCARAGAGTGCTTG 37:C  Resume Paused Jobs
Eetch Sequences i :’a""k Collapse Expanded Datasets
i ' ' rac
Fetch Alignments 710811 13(7BCBB<B(BE?BBACABBBBEBBGCABAB Include Deleted Datasets
Get Genomic Scores @SRRO64154.222 HWUSI-EAS627_1:8:1:3:1820 length=38 36: C Include Hidden Datasets
Operate on Genomic Intervals CCGONNNCCACTATCACGGCAGCGACGTCTCCACAAGC —:f‘f;a Unhide Hidden Datasets
isti iffe|
Statistics Delete Hidden Datasets
Waveiet Analysls 3: http:/ /biocluster.ucr.edu/~nkatiyar/Galaxy workshop/Rnaseq/SRR064167.fastq @ 35: € Purge Deleted Datasets
Graph/Display Data data
B . 2 Show Structure
Regional Variation 4: http:/ /biocluster.ucr.edu/~nkatiyar/Galaxy workshop/Rnaseq/tairlOchr.fasta @ EPKN
7 i Export to File
Multiple regression ) =
e i 5: hutp:/ /biocluster.ucr.edu/~nkatiyar/Galaxy workshop/Rnaseq/TAIR10.GTF @ 34:C Dpelete
Multivariate Analysis data
R B Delete Permanently
Evolution 6: http:/ /biocluster.ucr.edu/~nkatiyar/Galaxy workshop/Rnaseq/SRR064155.fastq @ diffey - o ;
OT} X ACTIONS
Motif Tools =
: - s :/ /bi .ucr. ~ i A EEHLY y i
Multiple Alignments 7: http:/ /biocluster.ucr.edu/~nkatiyar/Galaxy workshop/Rnaseq/SRR064166.fastg @ R Import from File
Metagenomic analyses 8: FASTQ Groomer on data 1 @ tracking
FASTA manipulation ’
g = : 32: Cuffdiff on data 19, @ ¢ &8
NGS: OC and manipulation 9: FASTQ Groomer on data 6 @
= data 15, and others: CDS FPKM
10: FASTO Groomer on data 3 @ differential expression testing

16



User Account

» An account is not required to access the Galaxy public Main
or Test instances,

» But if used, the data quota is increased and full functionality
across sessions opens up, such as naming, saving, sharing,

and publishing Galaxy objects (Histories, Workflows,
Datasets, Pages).

17
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NGS Data

» Raw: Sequencing Reads (FASTQ)

» Derived
- Alignments against reference genome
- SAM / BAM
- VCF / BCF
- Annotations
- GFF / GTF
- BED

19



FASTQ Format

4

4

A FASTQ file normally uses four lines per sequence.

Line 1 begins with a ‘@’ character and is followed by a
sequence identifier.

Line 2 is the raw sequence letters.

Line 3 begins with a ‘+’ character, is optionally followed by
the same sequence identifier.

Line 4 encodes the Phred quality values for the sequence in
line 2, each value represents the error probability of a given
base call.

ESRR064154.208 HWUSI-EAS627 1:8:1:2:1681 length=38
ANGANNNGGACTTTGAAAACACAGTCAAAGAGTGCTTG

+

2!108!! !3C?BCBB<BCBB?BBACABBBBBBBECABAB

20



FASTQ Quality Score (Link)

» Quality score represents the error probability of a given
basecall.

» In a FASTQ file, quality scores are often represented using the
ASCII alphabet.

» For example, a Phred score of 40 can be represented as the
ASCII char “I” (40+33= ASCII #73), and an lllumina score of 40
as “h” (40+64=ASCII #104).

» The range of scores will depend on the technology and the
base caller used, but will typically be up to 40.

ILI...LL,I.,.I.T.,T.L.T.T.T..T.T.T.T.T. L. LI L. L. . L L L L L L L L L L L L L T . & & s v e e e e o e e o o e oo aeeeoencececencsoncsencsnccsenscsnsscsenoesnss
'TES%ET () *+,-./0123456789: ;<=>2@ABCDEFGHIJKLMNOPQRSTUVWXYZ [\]”_‘abcdefghijklmnopgrstuvwxyz{|}~
| | | | | |

33 59 64 73 104 126
Uococcocococoococococococooc@®oooddlcocococ 40
=Sococl®@cococooo 2)ocococococococo0oco000mOCO0COC0OG 40
@cocococoooo H)ococococ000000000000000C0C000 40
UoZoocooocomsococococococoo@Boooddicococococ 41

Sanger Phred+33, raw reads typically (0, 40)
Solexa Solexa+64, raw reads typically (-5, 40)
Illumina 1.3+ Phred+64, raw reads typically (0, 40)

Illumina 1.8+ Phred+33, raw reads typically (0, 41) 21




SAM Format

(e]

(e]

For more details:
http://samtools.sourceforge.net/SAM1 .pdf

SAM stands for Sequence Alignment/Map format.

(e]

(e]

Consists of header and alignment section
11T mandatory fields

Tools

QNAME

search tools

Get Data

Send Data

ENCODE Tools
Lift-Over

Text Manipulation
Filter and Sort

loin, Subtract and Group
Convert Formats
Extract Features

Fetch Sequences

Fetch Alignments

Get Genomic Scores
Operate on Genomic Intervals
Statistics

Wavelet Analysis
Graph/Display Data
Regional Variation
Multiple regression
Multivariate Analysis
Evolution

Motif Tools

Multiple Alignments
Metagenomic analyses
FASTA manipulation
NGS: Mapping

NGS: Indel Analysis

NGS: RNA Analysis
NGS: SAM Tools

0

@SQ SN:Chrl LN:30427671
@SQ SN:Chr2 LN:19698289
@SQ SN:Chr3 LN:23459830
@SQ SN:Chrd LN:18585056
@SQ SN:Chrs LN:26975502
@SQ SN:ChrC LN:154478

@SQ SN:ChrM LN:366924

>

SRR038850.507 16
SRR038850.576 0
SRR038850.877 0
SRRO38850.889 16
SRR038850.1208 16
SRR038850.1343 0
SRR038850.1467 0
SRR038850.1539 0
SRR038850.1560 16
SRR038850.1597 0
SRRO38850.1646 0
SRR038850.1762 0
SRR038850.1788 16
SRR038850.2044 0
SRR038850.2048 16
SRR038850.2075 16
SRR038850.2238 0
SRR038850.2329 16
SRR038850.2456 16
SRR038850.2498 16
SRR038850.2688 16
SRR038850.2914 16
SRR038850.3049 16

(@PG ID:bwa PN:bwa VN:0.5.
SRR038850.12 0
SRR038850.74 0

9-r16
ChrC
ChrC
ChrC
ChrC
Chr3
Chr2
Chr2
ChrC
ChrC
ChrC
ChrC
ChrM
ChrC
ChrC
ChrM
ChrC
ChrC
ChrC
Chr3
ChrC
ChrC
Chr2
Chr3
Chr2
Chr3

FLAG RNAME POS

26323
148438
2951
94272
13539059
8961
5248
14160
64267
52063
35449
34461
22488
29055
32009
10959
35900
44906
14202983
6803
24537
7446
14198274
1606
14199230

MAPQCIGAR

37

37

23
37
37
37
37
37
37
37
37
37
37

37

o o o o

36M
36M
36M
36M
36M
36M
36M
36M
36M
36M
36M
36M
36M
36M
36M
36M
36M
36M
36M
36M
36M
36M
36M
36M
36M

MRNMMPOSISIZESEQ

O O 0 0 0 0 00 0000000000000 00 o o

o - - T - - =T = T T T - -]

CAAGCATCTTTTTTGAATTTCCCATTTATCCGTTTA
TTTTTGGAATAGATTCCATTTTGAGAGAGTTGAAAA
AAAAATCTTGGATTCAAAATTGATTTTTTTTTAATA
ATTATGCCTTGAAGAGGACTCGAACCTCCACGCTCT
CTCTCATATCTCCCTCGAATAAAGCTAAATTCTTTG
TGTGGCAGCCAAGCGTTCATAGCGACGTTGCTTTTT
ATGGGGATAGATCATTGCAATTGTTGGTCTTCAACG
ACAACGACTAATTCATCGGCTAATATATTTCCGAAA
TATCGAATACTGGTAATAATATCAGCAAAAGAACGT
TAACTCAGTGGTTAGAGTATTGCTTTCATACGGCAG
GCCCTATGAGTTAATACGATCACTATGTAGAGAAAG
TTTCTCTCGAACTAACATATCATCCAGCTTCTATCG
AATCGCCTTTTTTTTTATTTGGCAGTATTGAATACA
CCAATAAAAAAAAAAGTTCTTTATGATTCTTTTTCC
CCAGTAAAGGTCTAATTCTTAGTTTTTCTATTTTAT
ATTAATTCTCGCTGGCCGCGTCCTATAGGCATCATG
AGTCTTCTTGGTGGGTATCCTTAATTCTCTTATCTC
TCTTTCCGTACTTTCAACAAATTCACCAATCTTACG
GCTCTTCCTATCATTGTGAAGCAGAATTCACCAAGT
TAAAACTTACTTTATTGATCATTACATAGAATTCAA
ACGATCTTCTCAGTGTCAGTATAAAGGATTTTTCCC
AAATGGATGGCGCTTAAGCGCGCGACCTATACCCGG
AGCGTATATTTAAGTTGTTGCAGTTAAAAAGCTCCT
AGTTTAGGATGTCAAGTTTGCATCAAATATGCCCAC
TCATTGCAATTGTTGGTCTTCAACGAGGAATTCCTA

QUAL

@@<@?@BBAAB@> > = ==7@AB?7= <:6>@A@:7:
BBBBAABAABAAABBBBBBB?A?A>B>B@=B=>AAB
@@<9<(@BA@BB@BBBBBB@>A> <ABAB@?57:BAA<
?BCCBCCCCCBCCBBABBBBB>CBBC@CBBBACBCC
BCCCCCCBCCCBCBBBCBCCCCBCBBBBABCBCER?
B<@==,7762@67,@BB <?@@A <B=AACBBAB?CBA

BAB@BBEB ( AR @

BAC?CCCB@BCCCCCBB7@BABCACACCB=@CBBCC
75@BCBB@B@B==;CBBBCBCBBBB@>77@ABCEES
9CCBCCCCABAGBCBC?5BBE> @CB<=CA@BCBCBA
AB=B8BABBBCCBBCICBCCB=BCCCRBCCCCCCCH
BBBC@B@CB=BBBBCABAB@@B@BBBABAG@ABAT?
B7BCAABBCBCBBEB=BAB;S > @B@7A>AB>  <@=
BA@<@@@BBBABBA@IIAABBAA@=>7BABBBABGA
97AAC===B=A>CAAB@BBB>ABBBAB: <B:B:A<B
ABCCBCCCCCCCBBBCCCCCBCCCCCCBABBBCCCC
AA=BBBBCY8BB; > CBB@>ABBBBBABB@A> BB>A
9AABB> =AA=>B@A@BAB@@ACBAB7B> BBIBBBECH
AABICBBCCCCCCCBC=>AB>BCA@BBBBBBBBBBA
A@@B@ABC:ABAAB?BB@BBEBE?=ABCBCBAACBE
{BA7A@ABA?(BBBBBBEBBEEBBBB8B8B=BAB=B
>A@AA?> AA@=ATBBA@@AA=ATBS: <> BATBCAAB
CBB@BBBCBCBBBBI?A>B
A<BBAA@@BB@B?8?@@BA= BBBBB<B
AABBBABBBBBBBBBEA> @BAB@ABCBBBCBBBCACA

OPT

XT:A:U NM:i:0 X0:i:1 X1:0:0 XM:i:0 X0:1:0 XG:i:0 MD:Z:36

XT:AR NM:i:1 X0:0:2 X1:i:0 XM:i:1 X0:1:0 XG:i:0 MD:Z:1G:

XT:A:U NM:i:0 X0:i:1 X1:1:0 XM:i:0 X0:i:0 XG:i:0 MD:Z:36
XT:AR NM:i:0 X0:1:2 X1:i:0 XM:i:0 X0:i:0 XG:i:0 MD:Z:36
XT:AR NM:i:0 X0:1:2 X1:i:0 XM:i:0 X0::0 XG:i:0 MD:Z:36
XT:A:R NM:i:0 X0:1:2 X1::0 XM:i:0 X0:i:0 XG:1:0 MD:Z:36
XT:AR NM:i:0 X0:1:2 X1:i:0 XM:i:0 X0:i:0 XG:i:0 MD:Z:36
XT:A:U NM:i:0 X0:i:1 X1:i:1 XM:i:0 X0:i:0 XG:i:0 MD:Z:36
XT:A:U NM:i:0 X0:i:1 X1:0:0 XM:i:0 X0:i:0 XG:i:0 MD:Z:36
XT:A:U NM:i:0 X0:i:1 X1:i:0 XM:i:0 X0:1:0 XG:i:0 MD:2:36
XT:A:U NM:i:0 X0:i:1 X1:i:0 XM:i:0 X0:i:0 XG:i:0 MD:Z:36
XT:A:U NM:i:0 X0:i:1 X1:1:0 XM:i:0 X0:i:0 XG:i:0 MD:Z:36
XT:A:U NM:i:0 X0:i:1 X1:1:0 XM:i:0 X0:i:0 XG:i:0 MD:Z:36
XT:A:U NM:i:0 X0:i:1 X1:i:0 XM:i:0 X0:i:0 XG:i:0 MD:Z:36
XT:A:U NM:i:0 X0:i:1 X1:i:0 XM:i:0 X0:i:0 XG:i:0 MD:Z:36
XT:A:U NM:i:0 X0:i:1 X1:0:0 XM:i:0 X0:i:0 XG:i:0 MD:Z:36
XT:A:U NM:i:0 X0:0:1 X1:0:0 XM:0:0 X0:i:0 XG:i:0 MD:Z:36
XT:A:U NM:i:0 X0:i:1 X1:i:0 XM:i:0 X0:i:0 XG:i:0 MD:2:36
XT:A:R NM:i:0 X0:i:2 X1:i:0 XM:i:0 X0:i:0 XG:1:0 MD:Z:36
XT:A:U NM:i:0 X0:i:1 X1:1:0 XM:i:0 X0:i:0 XG:i:0 MD:Z:36
XT:A:U NM:i:0 X0:i:1 X1:1:0 XM:i:0 X0:i:0 XG:i:0 MD:Z:36
XT:AR NM:i:0 X0:1:2 X1:i:0 XM:i:0 X0::0 XG:i:0 MD:Z:36
XT:AR NM:i:0 X0:1:2 X1:i:0 XM:i:0 X0:1:0 XG:i:0 MD:Z:36
XT:AR NM:i:0 X0:1:2 X1:i:0 XM:i:0 X0:1:0 XG:i:0 MD:Z:36
XT:AR NM:i:0 X0:1:2 X1:i:0 XM:i:0 X0:i:0 XG:i:0 MD:Z:36

History R

SNPseq_Analysis_Galaxy_worksho
p2013

308.4 MB

15: beftools view on data @ ) 8
B

14: MPileup on data 7 and ® { %
data 10 (log)

13: MPileup on data 7 and ® 8
data 10

10: SAM-to-BAM on data @ {/ %
7 and data 9: converted BAM

%Map withBWAfor @/ &%
Illumina on data 8 and data 7:

mapped reads

~100,000 lines, 8 comments
format: sam, database: ?

BWA Version: 0.5.9-r16 BWA run on
single-end data

dOOR

1.QNAME 2.FLAG 3.RNAME 4.POS 5.MAPQ

@s0 SN:Chrl LN:3@427671
@0 SN:Chr2 LN:19698289
@0 SN:Chr3 LN:23459830
@50 SN:Chrd LN:18585056
@0 SN:Chr5 LN:26975502
@s0 SN:ChrC LN:154478

8:Filter FASTQon data 3 @ {/ %
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GFF and GTF format

» General Feature Format (GFF) (Link)

browser position chr22:10000000-10025000
browser hide all
track name=regulatory description="TeleGene(tm) Regulatory Regions"

visibility=2

chr22 TeleGene enhancer 10000000 10001000 500 + . touchl
chr22 TeleGene promoter 10010000 10010100 900 + . touchl
chr22 TeleGene promoter 10020000 10025000 800 - . touch2

» Gene Transfer format (GTF) (Link)
» The list attribute must begin with 2 mandatory attributes.
» Gene_id_value, transcript_id_value

gene_id "Em:U62317.C22.6.mRNA"; transcript id "Em:U62317.C22.6.mRNA"; exon_ number 1




VCF header

Body

BED format (Browser Extensible Data) (Link)

» Flexible way to define the data lines in the annotation track.

track name=pairedReads description="Clone Paired Reads" useScore=1l
chr22 1000 5000 cloneA 960 + 1000 5000 0 2 567,488, 0,3512
chr22 2000 6000 cloneB 900 - 2000 6000 O 2 433,399, 0,3601

BCF / VCF format » VCF: Variant Calling Format (Link)
» BCF: Binary version of VCF

( ##fileformat=VCFv4.0 = Mandatory header lines
##fileDate=20100707

##source=VCFtools

##reference=NCBI36

##INFO=<ID=AA,Number=1, Type=String,Description="Ancestral Alle
##INFO=<ID=H2 ,Number=0, Type=Flag,Description="HapMap2 member
##FORMAT=<ID=GT, Number=1,Type=String,Description="Genotype)
##FORMAT=<ID=GQ, Number=1,Type=Integer,Description="Genotyfe Quality (phred score)">
##FORMAT=<ID=GL, Number=3,Type=Float,Description="LikeliAoods for RR,RA,AA genotypes (R=ref,A=alt)">
##FORMAT=<ID=DP, Number=1,Type=Integer,Description="Re#d Depth">

##ALT=<ID=DEL ,Description="Deletion">
##INFO=<ID=SVTYPE,Number=1, Type=String,Descripti

Optional header lines (meta-data

about the annotations in the VCF body)

="Type of structural variant">

##INFO=<ID=END,Number=1,Type=Integer,Description="End position of the variant"> =
\ #CHROM POS ID REF ALT  QUAL FILTER INFO FORMAT SAMPLE1 SAMP LI LS HES0)
1 1 . ACG_ A,AT PASS . GT:DP 1/2:13 0/0%29
1 2 rsl T,CT PASS H2; AA=T GT:GQ 0]1:100 2/2Y0
1 5 . A G . ASS . GT:GQ |0:77 1/1:9
1 100 T, <DEL> . P SVTYPE=DEL ; END=300 GT:GQ:DP /1:12:3 0/0:20 Alternate alleles (GT>0 is
h an index to the ALT column)
- ot t
Deletion SNP Incertion ereven Phased data (G and C above
Large SV are on the same chromosome)

- —_ 3



Available NGS Analysis Toolsets

» Prepare, Quality Check and Manipulate FASTQ
reads

» Mapping

» SAMtools

» SNP and INDEL analysis
» RNA-seq analysis

» Peak calling / ChlP-seq
» Many more.....
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NGS Analysis Using Galaxy

» Galaxy overview and Interface
» Getting Data in Galaxy

» Analyzing Data in Galaxy
> Quality Control
- Mapping Data
» History and workflow
» Sequences and Alignment Format

» Galaxy Exercises
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Getting started with Galaxy

-_ Galaxy

Data intensive biology for everyone.

Galaxy is an open, web-based platform for data intensive biomedical
research. Whether on the free public server or your own instance, you can

perform, reproduce, and share complete analyses.

Use Galaxy Get Galaxy Learn Galaxy Get Involved

Advanced fastQ

manipulation

Install locally or In the cloud Screencasts, Galaxy 101, ... Mailing lists, Tool Shed, wiki

Use project's free server
or other public servers or get Galaxy on SlipStream

Search all resources

The Galaxy Team is a part of BX at Penn State, and the Biology and Mathematics and

Computer Science departments at Emory University. The Galaxy Project is supported in part

by NHGRI, NSF, The Huck Institutes of the Life Sciences, The Institute for CyberScience at

Penn State, and Emory University.

http://galaxyproject.org/




Galaxy Conceptual Framework

-. Gali Info: report bugs | wiki | screencasts | blog  Logg
gools Home Genomes Genome Browser Blat Tables Gene Sort
Get Data JlliFAQ  Help
" e -

bl Table Browser

Use this program) [l Ga|axy Info: n_port bugs | wiki | screencasts | blog  Logged in as wlathe@openhelix.com: manage | logout

= UCSC Archaea table browser i ions bet

EE— 5 S Tools History Options
= Get Microbial Data this ‘ et Dala Fiiter

BTe : User's Guide for T, Filter: refresh | collapse all
= BioMart Central server Send Data -

z for a narrated prej ENCODE Tools [2: ChrXGenes —
= Elymine server want}o use Galay Lift-Over ‘1 UCSC Main on Human: knownGene = Ga|axy fo: report bugs | wiki | screencusts | blog  Logged in as wiathe@openhelix.com: manage | logout
= EncodeDB at NHGRI contributors and § 7 yanipulation | 2: ChrXGenes :
= EDIGRAPH server clade: | Mammal | Filter and Sort 6<=2 I::h_ o M | History Options
Get ENCODE Data group: | Genesanf * %:a“’ on any column using Double equal signs, ==, must be used as sho| Extract Features oIt refresh | coll I N
st arbitrary string, use the Select tool. i

Fetch Sequences " o
Send Data (addcustomwacks) e o F"‘: = “‘"‘“; [7: Flanks ChrXGenes <=2 Exons |4 7: Flanks ChrXGenes ® ) 3%
G — S ( ) Fetcl nment Exons
ENCODE Tools table: [ knownGenf  descending order Execute Eeteh Alignments First query <=2 Exons
TR — Get Genomic Scores 436 regions, format: interval,
Lift-Over || region: O gend * Select Illnes that match an Onarata on Ganomic Intervals with: database: hg18
P ( define regions ) SR Doutie Shusl snsy ==gmustbe teed 25 "e| u Intersect the intervals of two ['6: Dnase HS on ChromxX ) x‘;“; Locaon ) ‘Zﬁ"?o'g‘ gffgizi"
Filter and Sort ———————""| Join, Subtract and Grou chr22') queries M| | second query TG RS S G
Join, Subtract and Grou identifiers (namf convert Formats o rhxp;mempn?g to apply a ﬁlterm? conditio] = Subtract the intervals of two withiialiovertaps save | display at UCSC main
. FASTA manipulation the data type (e.q., string, integer) in every|  queries o
ConvertEormats filter: (‘create) e filtered is not appropriate for the condition (| 1
FASTA manipulation intersection: (? e numerical calculations on strings). If an excq = Merge the overlapping (bp) HEx 157038 157539
Bxtract Feati —| Fetch Sequences applying the condition to a line, that line is intervals of a query G
et correlation: (cr{ Fetch Alignments ‘| filter condition. The number of invalid skippd L Return: chrx 719513 720013 +
Fetch Sequences Tl eas s the resulting history item as a "Condition/da| ® Soncatenate two g ( = chrx 1616000 1616500 -
output fo Get Genomic Scores one query Only records that are joined (INNER JOIN) F%-{
Fetch Alignments TmAt: | o erate on Genomic Intervals @ TIP: If your data is not TAB delimited, use |, Base Coverage of all intervals chrX 1545451 1545951 -
Get Genomic Scores output file: myirf Statistics a - i : Execute chrXx 2429015 2429515 -
O G il hrx 2428580 2429080 -
Operate on Genomic Intervals file type returné Graph/Display Data Syntax ‘o secofid set of Intervals s S<TE
Statistics lonal Veriation The filter tool allows you to restrict the datset U s Complement intervals of a .| @ TIP: 1f your query does not appear in the pulldown menu -> itis notin (1),
Graph/Display Data Multiple regression statements query interval format. Use "edit attributes" to set chromosome, start, end,
("get output ) (" sunf HyPhy and strand columns 6: Dnase HS on ® )%
ional Variation " A sl * Columns are referenced with ¢ and a nuf = Cluster the intervals of a ChromxX
Multiple regression FExOHOmyIHEHIpUIS Hon refers to the first column of a tab-delimitf  query Ty
Evolution: HyPh To reset all user ¢ EMBOSS « Make sure that multi-character operators| o ; Screencasts! da[a;eags:n:,g& at: bed,
olution: HyPhy e.g., <= is valid while < = is not valid ) | * Join the intervals of two A % it z V
e e———— . e « When using 'equal-to' operator double e queries side-by-side See Galaxy Interval Operation Screencasts (right click to open this link in Info: }
Taxonomy manipulation S o used ( e.g., cl=='chr1" - another window). save | display at UCSC main
worldlow (beta) « Non-numerical values must be included if " iﬁ:ﬂl’;k:om‘:: ::::‘"9 S S
« Filtering condition can include logical ope| u Fetch closest feature for every . chrx 3621172 3621566 1 2
operators are all lower case ( e.q., (c|EERKIERAl * Where overlap specifies the minimum overlap between intervals chrX 7061139 7061247 2 2
cli="chrY') or not c6=="+") 5 that allows them to be joined.
* Profile Annotations for a set of « Return only records that are joined returns only the records of chrx 9269213 9269631 3.2
Example genomicintervals the first query that join to a recond in the second query. This is chex 9943173 9943208 4.2
Statistics analogous to an INNER JOIN. chrx 10024268 10024749 5 2
1ootehet! cotacke | bich tha & « Return all records of first query (fill null with ".") returns all
Graph/Display Data intervals of the first query, and any intervals that do not join an chrX 11687566 11688073 6.3
Regional Variation i interval from the second query are filled in with a period(.). This is &9 <>
Multiple ression analogous to @ LEFT JOIN. )
bl Lo e S « Return all records of second query (fill null with ".") returns
Evolution: HyPh all intervals of the second query, and any intervals that do not join 4: UCSC Main on ® 0 R
Taxonomy manipulation e an interval from the first query are filled in with a period(.). Note | || Human: nhariDnaseHs Y
EMBOSS that this may produce an invalid interval file, since a chrX:1-153692391
e v docdl ) In not o walid cheam atart and or strand v v
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Galaxy Interface Sections Login

Register
Galaxy Analyze T
&

Tools History °
Institute for Integrative Unnamed history

| search tools (x] ;

————————— Genome Biology 508.1 MB OB
Get Data
Send Data 49: SAM-to-BAMon data @ { %
ENCODE Tools 42 and data 48: converted BAM
Lift-Over Welcome to IIGB's Galaxy Server!

48: Map with BWAfor @ ) ¢
Text g Overview lumina on data 47 and data 42:
B ic ananan_highly customizable, web-based platform for the analysis of next generation sequence data and many other biological data types. It enables userg-tasuncazs apped reads

ion sequencing analysis tasks on powerful server hardware from a graphical web browser-based user interface rather than the Linux comma
Galaxy is given in the left pane. Much more detailed descriptions of Galaxy's basic functionalities including user tutorials are available here.

ice?
hges of using a local Galaxy server here at UCR rather than public test instances of Galaxy available on the internet. The most important are
s; (2) elimination of time consuming uploads of large data sets; (3) support for analyzing much larger data sets than this is possible on publ
ware tools and database collections.

ns on IIGB's high performance compute (HPC) infrastructure, called Biocluster. As such its usage is covered by the annual registration fee
sers with an active Biocluster account can access this Galaxy service using their existing user name and password without any extra cost. N

Multiple reqression IS Service can De sent to support@biocluster.ucr.edu. Galaxy workshon/Snbsea/tai
ar/Galaxy workshop/Snpseq/tai
Multivariate Analysis r10chr.fasta
Evolution Additional Databases and Sofware Tools
Motif Tools Support requests for including additional reference genomes and s aL: )R
o http://biocluster.ucr.edu/~nkatiy
Multiple Alignments ar/Galaxy workshop/Snpseq/SR
Metagenomic analyses Workshops on Galaxy R038850.fastq
FASTA manipulation Past and future UCR workshop events on using Galaxy are listed h
o 37: Top-5 Exons @R
NGS: OC and manipulation
NGS: Mapping Enter IIGB's Galaxy Service 32: Top-5 Exons @)%
NGS: Indel Analysis 0 enter this service, click here.
. : Top-
NGS: RNA Analysis 27:Too5 Exons /X
NGS: SAM Tools 22: Top-5 Exons @R
NGS: GATK Tools (beta)
NGS: Peak Callin 17: Top-5 Exons ® %
NGS: Simulation 12: Top-5 Exons ®0R
SNP/WGA: Data; Filters
Phenotype Association 7: Top-5 Exons @R
NCF Tools 2: UCSC Main on Human: ® { %
Workflows rmsk (genome)
* Allworkflows 1: UCSC Main on Human: ® () %
knownGene (genome
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NGS Analysis Using Galaxy

» Sequences and Alignment Format
» Galaxy overview and Interface
» Getting Data in Galaxy

» Analyzing Data in Galaxy
> Quality Control
- Mapping Data

» History and workflow

» Galaxy Exercises
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Getting Data

search tools

Get Data
Send Data
ENCODE Tools
Lift-Over
Text Manipulation

Filter and Sort

Join, Subtract and Group
Convert Formats

Extract Features

Fetch Sequences

Fetch Alignments

Get Genomic Scores

Operate on Genomic Intervals
Statistics

Wavelet Analysis
Graph/Display Data

Regional Variation

Multiple regression
Multivariate Analysis
Evolution

Motif Tools

Multiple Alignments
Metagenomic analyses
FASTA manipulation
NGS: QC and manipulation
NGS: Mapping

NGS: Indel Analysis
NGS: RNA Analysis
NGS: SAM Tools

NGS: GATK Tools (beta)
NGS: Peak Calling

NGS: Simulation
SNP/WGA: Data; Filters
Phenotype Association
VCF Tools

Workflows
= All workflows

Analyze Data

11 M1 | Institute for Inteorative

Welcome to IIGB's Galaxy Server!

Overview

Galaxy is an open, highly customizable, web-based platform for the analysis of next generation sequence data and many other biological data types. It enables users to run computationally
demanding next generation sequencing analysis tasks on powerful server hardware from a graphical web browser-based user interface rather than the Linux command-line. A subset of of
application supported by Galaxy is given in the left pane. Much more detailed descriptions of Galaxy's basic functionalities including user tutorials are available here.

Why Local Galaxy Service?

There are many advantages of using a local Galaxy server here at UCR rather than public test instances of Galaxy available on the internet. The most important are: (1) shorter waiting
queues for analysis tasks; (2) elimination of time consuming uploads of large data sets; (3) support for analyzing much larger data sets than this is possible on public services; (4) the
ability to customize software tools and database collections.

How to Gain Access?
This instance of Galaxy runs on IIGB's high performance compute (HPC) infrastructure, called Biocluster. As such its usage is covered by the annual registration fee for this infrastructure
(see here for details). Users with an active Biocluster account can access this Galaxy service using their existing user name and password without any extra cost. New account requests for

this service can be sent to support@biocluster.ucr.edu.

Additional Databases and Sofware Tools
Support requests for including additional reference genomes and software tools on IIGB's Galaxy server can be sent to support@biocluster.ucr.edu

Workshops on Galaxy
Past and future UCR workshop events on using Galaxy are listed here. The user manual from previous workshops can be accessed here.

Enter IIGB's Galaxy Service
To enter this service, click here.

Using 0%

History

Unnamed history
0 bytes @8

© vour history is empty. Click 'Get
Data' on the left pane to start
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Getting Data

-~ Galaxy

Tools

search tools (]

Get Data

Upload File from your
computer

UCSC Main table browser
UCSC Test table browser
UCSC Archaea table browser
BX table browser

EBI SRA ENA SRA

Get Microbial Data

BioMart Central server

BioMart Test server

CBI Rice Mart rice mart
GrameneMart Central server
modENCODE fly server
Flymine server

Elymine test server
modENCODE modMine server
MouseMine server

Ratmine server

YeastMine server

metabolicMine server
modENCODE worm server
WormBase server
Wormbase test server
EuPathDB server

EncodeDB at NHGRI

EDIGRAPH server
EDIGRAPH test server

HbVar Human Hemoglobin
Variants and Thalassemias

GenomeSpace import from file
browser

Send Data

Analyze Data

History c8
U C R Institute for Integrative Unnamed history
! Genome Biology 0 bytes 7B

ﬂ Your history is empty. Click 'Get
Data' on the left pane to start

Welcome to IIGB's Galaxy Server!

Overview

Galaxy is an open, highly customizable, web-based platform for the analysis of next generation sequence data and many other biological data types. It enables users to run computationally
demanding next generation sequencing analysis tasks on powerful server hardware from a graphical web browser-based user interface rather than the Linux command-line. A subset of of
application supported by Galaxy is given in the left pane. Much more detailed descriptions of Galaxy's basic functionalities including user tutorials are available here.

Why Local Galaxy Service?

There are many advantages of using a local Galaxy server here at UCR rather than public test instances of Galaxy available on the internet. The most important are: (1) shorter waiting
queues for analysis tasks; (2) elimination of time consuming uploads of large data sets; (3) support for analyzing much larger data sets than this is possible on public services; (4) the
ability to customize software tools and database collections.

How to Gain Access?
This instance of Galaxy runs on 1IGB's high performance compute (HPC) infrastructure, called Biocluster. As such its usage is covered by the annual registration fee for this infrastructure
(see here for details). Users with an active Biocluster account can access this Galaxy service using their existing user name and password without any extra cost. New account requests for

this service can be sent to support@biocluster.ucr.edu.

Additional Databases and Sofware Tools
Support requests for including additional reference genomes and software tools on IIGB's Galaxy server can be sent to support@biocluster.ucr.edu

Workshops on Galaxy
Past and future UCR workshop events on using Galaxy are listed here. The user manual from previous workshops can be accessed here.

Enter IIGB's Galaxy Service
To enter this service, click here.
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Import data from UCSC genome browser

-~ Galaxy

Tools

search tools

Get Data

Upload File from your
computer

UCSC Main table browser
UCSC Test table browser
UCSC Archaea table browser
BX table browser

EBI SRA ENA SRA

Get Microbial Data

BioMart Central server

BioMart Test server

CBI Rice Mart rice mart
GrameneMart Central server
modENCODE fly server
Flymine server

Flymine test server
modENCODE modMine server
MouseMine server

Ratmine server

YeastMine server
metabolicMine server
modENCODE worm server
WormBase server
Wormbase test server

EuPathDB server

EncodeDB at NHGRI

Analyze Data

U C R Institute for Integrative
Genome Biology

s Galaxy Server!

Overview

Galaxy is an open, highly customizable, web-based platform for the analysis of next generation sequence data and many other
biological data types. It enables users to run computationally demanding next generation sequencing analysis tasks on powerful
server hardware from a graphical web browser-based user interface rather than the Linux command-line. A subset of of application
supported by Galaxy is given in the left pane. Much more detailed descriptions of Galaxy's basic functionalities including user tutorials
are available here.

Why Local Galaxy Service?

There are many advantages of using a local Galaxy server here at UCR rather than public test instances of Galaxy available on the
internet. The most important are: (1) shorter waiting queues for analysis tasks; (2) elimination of time consuming uploads of large
data sets; (3) support for analyzing much larger data sets than this is possible on public services; (4) the ability to customize software
tools and database collections.

How to Gain Access?

This instance of Galaxy runs on IIGB's high performance compute (HPC) infrastructure, called Biocluster. As such its usage is covered
by the annual registration fee for this infrastructure (see here for details). Users with an active Biocluster account can access this
Galaxy service using their existing user name and password without any extra cost. New account requests for this service can be sent
to support@biocluster.ucr.edu.

Additional Databases and Sofware Tools
Support requests for including additional reference genomes and software tools on IIGB's Galaxy server can be sent to
support@biocluster.ucr.edu

Workshops on Galaxy
Past and future UCR workshop events on using Galaxy are listed here. The user manual from previous workshops can be accessed
here.

Enter IIGB's Galaxy Service
To enter this service, click here.

Using 0%
History (S <]
Unnamed history
0 bytes =

© Your history is empty. Click 'Get
Data’ on the left pane to start
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Import data from UCSC genome browser

Genomes Genome Browser Tools Mirrors Downloads My Data Help About Us

Table Browser

Use this program to retrieve the data associated with a track in text format, to calculate intersections between tracks, and to retrieve DNA
sequence covered by a track. For help in using this application see Using the Table Browser for a description of the controls in this form,
the User's Guide for general information and sample queries, and the OpenHelix Table Browser tutorial for a narrated presentation of the
software features and usage. For more complex queries, you may want to use Galaxy or our public MySQL server. To examine the
biological function of your set through annotation enrichments, send the data to GREAT. Send data to GenomeSpace for use with diverse
computational tools. Refer to the Credits page for the list of contributors and usage restrictions associated with these data. All tables can
be downloaded in their entirety from the Sequence and Annotation Downloads page.

clade: Mammal v genome: Human v assembly: Feb. 2009 (GRCh37/hg19) ~
group: Genes and Gene Predictions v track: UCSC Genes v [ manage custom tracks H track hubs ]
table: knownGene v [ describe table schema ]

region: © genome © ENCODE Pilot regions © position chr7:127471196-127495720 | lookup || define regions |
identifiers (names/accessions): | pastelist || upload list |

filter:
intersection:
correlation:

output format: BED - browser extensible data v |Send output to ¥ Galaxy [| GREAT [] GenomeSpace
output file: (leave blank to keep output in browser)
file type returned: @ plaintext © gzip compressed

[ get output H summary/statistics ]

To reset all user cart settings (including custom tracks), click here.
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Send query to Galaxy from UCSC genome browser

Genomes Genome Browser Tools Mirrors Downloads My Data Help About Us

Output knownGene as BED

! Include custom track header:
name= tb_knownGene
description=table browser query on knownGene

visibility= I pack i

url=

Create one BED record per:

© Whole Gene

© Upstreamby 200 bases

) Exons plus 0 bases at each end
© Introns plus 0 bases at each end
© 5'UTR Exons

© Coding Exons

© 3'UTR Exons

© Downstream by 200 bases

Note: if a feature is close to the beginning or end of a chromosome and upstream/downstream bases are added, they may be truncated in
order to avoid extending past the edge of the chromosome.
[ Send query to Galaxy ]

Cancel
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Workflow

Analyze Data Data Libra: i SR RET

rﬂ]ﬂ f Desktop

browser
Get Microbial Data

BioMart Central server

GrameneMart Central server
Elymine server

EuPathDB server

EncodeDB at NHGRI
EpiGRAPH server

Send Data
ENCODE Tools
Lift-Over

Text Manipulation

Fetch Sequences

Fetch Alignments

Get Genomic Scores

Operate on Genomic Intervals
Statistics

Graph/Display Data

Regional Variation

Multiple regression

Evolution

Metagenomic analyses
EMBOSS

NGS TOOLBOX BETA

NGS: QC and manipulation
NGS: Mapping

» DEVICES

» PLACES

» MEDIA

format?

Choose File

URL/Text:

4
Here you may specify a list of URLs (one per line) o

Convert spaces to tabs:

i chrX_geneintervals.txt

TXT

Name chrX_geneinte

rvals.txt
Size 88 KB
Kind Microsoft
Excel text
document
Created Today at

<« »l

Horse Sep. 2007 {equCab2)
Horse Jan. 2007 (equCab1)
Human Feb. 2009 (hg19
Human Mar. 2006 (hg18)
Human May 2004 (hg17)
Human July 2003 (hg16)
Human Apr. 2003 (hg15)
Hyperthermus butylicus DSM 5456 (hypeButy1)
Hyphomonas neptunium ATCC 15444 (hyphNept ATCC15444)
Idiomarina loihiensis L2TR (idioLoih_L2TR)

J. Craig Venter Sep. 2007 (venter1)

Jannaschia sp. CCS1 (jannCCS1)

Kangaroo rat Jul. 2008 (dipOrd1)

Lactobacillus plantarum WCFS1 (lactPlan}

Lactobacillus salivarius UCC118 (lactSali_UCC118)
Lactococcus lactis subsp. lactis 111403 (lactLact)

"1 Hide extension

Al Lamprey Mar. 2007 (petMar1)

Lancelet Mar. 2006 (braFlo1)
Laurasiatheria Apr. 24. 2006 (lauRas13)
Lawsonia intracellularis PHE/MN1-00 (lawsintr PHE_MN1_00)

( Cancel ) ( Open

>l

ERiLg

Axt

blastz pairwise alignment format. Each alignment block in an axt file contains three lines:
a summary line and 2 sequence lines. Blocks are separated from one another by blank
lines. The summary line contains chromosomal position and size information about the

alignment. It consists of 9 required fields.

»(
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Getting Data: Upload File

® 00

Galaxy

| « | » | [+ [@nup://10calhost:8080/

Tools

Get Data 1{'

Upload File from your computer
UCSC Main table browser
UCSC Test table browser
UCSC Archaea table browser
BX main browser

Get Microbial Data

BioMart Central server
BioMart Test server
GrameneMart Central server
Flymine server

Flymine test server

modMine server "
Ratmine server

Wormbase server

Wormbase test server

EuPathDB server

EncodeDB at NHGRI

EpiGRAPH server

EpiGRAPH test server

HbVar Human Hemoglobin
Variants and Thalassemias

Send Data
ENCODE Tools
Lift-Over

Workflow Data Libraries

Analyze Data Help User

Upload File

File Format:

| Auto-detect %]

Which format? See help below

File:
( Choose File ) no file selected

URL/Text:
http://bx.mathcs.emory.edu/outgoing/da
ta/phiX174_genome.fa
http://bx.mathcs.emory.edu/outgoing/da

pr

Here you may specify a list of URLs (one per line) or paste
contents of a file.

Convert spaces to tabs:

[CYes

Use this option if you are entering intervals by hand.
Genome:

Click to Search or Select @®

_Execute

Auto -detect

The system will attempt to detect Axt, Fasta, Fastqsolexa, Gff, Gff3,
Html, Lav, Maf, Tabular, Wiggle, Bed and Interval (Bed with headers)
formats. If your file is not detected properly as one of the known
formats, it most likely means that it has some format problems (e.qg.,
different number of columns on different rows). You can still coerce

v

History

C] (Q' Google \

Options «

VIS

ﬂ Your history is empty. Click 'Get
Data’ on the left pane to start

Display a menu.
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NGS Analysis Using Galaxy

» Sequences and Alignment Format
» Galaxy overview and Interface
» Getting Data in Galaxy
» Analyzing Data in Galaxy
o Lift-Over
- Text manipulation tools
> Filter and Sort
- Operate on Genomic Intervals

> Quality Control
- Mapping Data

» History and workflow
Galaxy Exercises
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Lift—-Over: convert genome coordinates

Tools

search tools ()

Get Data
Send Data
ENCODE Tools

Lift-Over

Convert genome coordinates
between assemblies and
genomes

Text Manipulation

Filter and Sort

Join, Subtract and Group
Convert Formats

Extract Features

Fetch Sequences

Fetch Alignments

Get Genomic Scores
Operate on Genomic Intervals
Statistics

Wavelet Analysis
Graph/Display Data
Regional Variation
Multiple regression
Multivariate Analysis
Evolution

Motif Tools

Multiple Alignments
Metagenomic analyses
FASTA manipulation
NGS: QC and manipulation
NGS: Mapping

NGS: Indel Analysis
NGS: RNA Analysis
NGS: SAM Tools

Convert genome coordinates (version 1.0.3)
Convert coordinates of:

v

To:

¥

Minimum ratio of bases that must remap:
0.95
Recommended values: same species = 0.95, different species = 0.10

Allow multiple output regions?:
No v
Recommended values: same species = No, different species = Yes

Make sure that the genome build of the input dataset is specified (click the pencil icon in the history item to set it if necessary).

This tool can work with interval, GFF, and GTF datasets. It requires the interval datasets to have chromosome in column 1, start co-ordinate in column 2 and end
co-ordinate in column 3. BED comments and track and browser lines will be ignored, but if other non-interval lines are present the tool will return empty output
datasets.

O what it does
This tool is based on the LiftOver utility and Chain track from the UC Santa Cruz Genome Browser.

1t converts coordinates and annotations between assemblies and genomes. It produces 2 files, one containing all the mapped coordinates and the other containing
the unmapped coordinates, if any.

Example

Converting the following hg16 intervals to hg18 intervals:

chrX 85170 112199 AK@@2185 © +
chrX 110458 112199 AK@97346 © +
chrX 112203 121212 AK@74528 @ -

will produce the following hg18 intervals:

chrX 132991 160020 AK0e2185 @ +
chrX 158279 1608020 AK@97346 @

+

History 8

Unnamed history

0 bytes &

O vour history is empty. Click 'Get
Data’ on the left pane to start
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Text manipulation tools

alaxy

Tools

search tools (x]

Get Data
Send Data
ENCODE Tools
Lift-Over

Text Manipulation
Add column to an existing
dataset

Compute an expression on
every row

Concatenate datasets tail-to-
head

Cut columns from a table
Merge Columns together
Convert delimiters to TAB

Create single interval as a new
dataset

Change Case of selected
columns

» Paste two files side by side

Remove beginning of a file

Select random lines from a file

Select first lines from a
dataset

Select last lines from a dataset

Trim leading or trailing
characters

Line/Word/Character count of

a dataset

Secure Hash / Message Digest

on a dataset

Analyze Data

Paste (version 1.0.0)

Paste:

Delimit by:
Tab v

 Paste preserves column assignments of the first dataset.

What it does

This tool merges two datasets side by side. If the first (left) dataset contains column assignments such as chromosome, start, end and strand, these will be preserved.
However, if you would like to change column assignments, click the pencil icon in the history item.

Example

First dataset:

al
a2
a3l

Second dataset:

20
30
40

Pasting them together will produce:

al?2e
a2 3e
a3 40

Using 0%

History [
Unnamed history
0 bytes =

O vour history is empty. Click 'Get
Data’ on the left pane to start
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Filter and Sort on Galaxy

- Galaxy

Tools

search tools (]

Get Data
Send Data
ENCODE Tools
Lift-Over
Text Manipulation
Filter and Sort
Filter data on any column

using simple expressions

Sort data in ascending or
descending order

Select lines that match an
expression

GFF

’ Extract features from GFF data

Filter GFF data by attribute
using simple expressions

Filter GFF data by feature
count using simple expressions

Filter GTF data by attribute
values list

Join, Subtract and Group
Convert Formats

Extract Features

Fetch Sequences

Fetch Alignments

Get Genomic Scores

Operate on Genomic Intervals
Statistics

Using 0%

Analyze Data

N =
Extract features (version 1.0.0) History Fs A )
Select GFF data: Unnamed history

v 0 bytes &=

O vour history is empty. Click 'Get
Data’ on the left pane to start

From:

Column 1 / Sequence name ¥

Extract features:

Multi-select list - hold the appropriate key while clicking to select multiple columns

What it does

This tool extracts selected features from GFF data.

Example

Selecting promoter from the following GFF data:

chr22 GeneA enhancer 10000000 10001000 560 + . TGA
chr22 GeneA promoter 10010000 10010100 900 + . TGA
chr22 GeneB promoter 10020000 10025000 400 - . TGB
chr22 GeneB (CDS2220 10030000 10065000 800 - . TGB

will produce the following output:

10010000
10020000

10010100 900 + . TGA
10025000 400 - . TGB

chr22 GeneA promoter
chr22 GeneB promoter

© About formats

GFF format General Feature Format is a format for describing genes and other features associated with DNA, RNA and Protein sequences. GFF lines have nine tab-
separated fields:
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Operate on Genomic Intervals

Analyze Data

Tools

Join, Subtract and Group
Convert Formats

Extract Features

Fetch Sequences

Fetch Alignments

Get Genomic Scores

Operate on Genomic Intervals
Intersect the intervals of two
datasets

Subtract the intervals of two
datasets

Merge the overlapping
intervals of a dataset

» Concatenate two datasets into
one dataset
Base Coverage of all intervals

Coverage of a set of intervals
on second set of intervals

Complement intervals of a
dataset

Cluster the intervals of a
dataset

Join the intervals of two
datasets side-by-side

Get flanks returns flanking
region/s for every gene

Fetch closest non-overlapping
feature for every interval

Profile Annotations for a set of
genomic intervals

Statistics

Wavelet Analysis
Graph/Display Data

Concatenate (version 1.0.1)

Concatenate:

v

First dataset

with:

v

Second dataset

Both datasets are same filetype?:
v

If unchecked Second dataset will be forced into format of First dataset

O e v your dataset does not appear in the pulldown menu -> it is not in interval format. Use "edit attributes” to set chromosome, start, end, and strand columns.

Screencasts!

See Galaxy Interval Operation Screencasts (right click to open this link in another window).

Syntax

Both datasets are exactly the same filetype will preserve all extra fields in both files. Leaving this unchecked will force the second dataset to use the same column
assignments for chrom, start, end and strand, but will fill extra fields with a period(.). In both cases, the output fields are truncated or padded with fields of periods to
maintain a truly tabular output.

Example

First dataset
Bt

Second dataset

Concatenated intervals

History N

Unnamed history

0 bytes =

O vour history is empty. Click 'Get

Data’ on the left pane to start

42



FASTA manipulation

Analyze Data

Using 0%

Tools

Graph/Display Data
Regional Variation
Multiple regression
Multivariate Analysis
Evolution

Motif Tools

Multiple Alignments
Metagenomic analyses
FASTA manipulation
RNA/DNA converter

FASTA Width formatter

Compute sequence length
Filter sequences by length

Concatenate FASTA alignment
by species

FASTA-to-Tabular converter

Tabular-to-FASTA converts
tabular file to FASTA format

NGS: QC and manipulation
NGS: Mapping

NGS: Indel Analysis

NGS: RNA Analysis

NGS: SAM Tools

NGS: GATK Tools (beta)
NGS: Peak Calling

'NGS: Simulation

£

RNA/DNA (version 1.0.0)

Library to convert:

v

Convert:
RNAtoDNA (UtoT) -

What it does

This tool converts RNA FASTA files to DNA (and vice-versa).
In RNA-to-DNA mode, U's are changed into T's.

In DNA-to-RNA mode, T's are changed into U's.

Example

Input RNA FASTA file ( from Sanger's mirBase ):

>cel-let-7 MIMATOQ00001 Caenorhabditis elegans let-7
UGAGGUAGUAGGUUGUAUAGUU
>cel-1lin-4 MIMAT0000002 Caenorhabditis elegans lin-4
UCCCUGAGACCUCAAGUGUGA
>cel-miR-1 MIMATO000003 Caenorhabditis elegans miR-1
UGGAAUGUAAAGAAGUAUGUA

Output DNA FASTA file (with RNA-to-DNA mode):

>cel-let-7 MIMATO000@01 Caenorhabditis elegans let-7
TGAGGTAGTAGGTTGTATAGTT
>cel-1in-4 MIMAT@000002 Caenorhabditis elegans lin-4
TCCCTGAGACCTCAAGTGTGA
>cel-miR-1 MIMAT0000003 Caenorhabditis elegans miR-1
TGGAATGTAAAGAAGTATGTA

History Fo A -
Unnamed history
0 bytes A=

O vour history is empty. Click 'Get
Data' on the left pane to start
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Analyzing Data: Next Generation Sequencing

Tools

search tools (]

Get Data

Send Data

ENCODE Tools

Lift-Over

Text Manipulation

Filter and Sort

Join, Subtract and Group
Convert Formats
Extract Features

Fetch Sequences

Eetch Alignments

Get Genomic Scores
Operate on Genomic Intervals
Statistics

Wavelet Analysis
Graph/Display Data
Regional Variation
Multiple regression
Multivariate Analysis
Evolution

Motif Tools

Multiple Alignments
Metagenomic analyses
FASTA maniBuIation
NGS: OC and manipulation
NGS: Mapping

NGS: Indel Analysis
NGS: RNA Analysis
NGS: SAM Tools

NGS: GATK Tools (beta)
NGS: Peak Calling

NGS: Simulation
SNP/WGA: Data; Filters
Phenotype Association
VCF Tools

Workflows

FastQC: Comprehensive QC | version 0.53 ¥ |
Short read data from your current history:

v

Title for the output file - to remind you what the job was for:

FastQC
Letters and numbers only please - other characters will be removed

Contaminant list:

Selection is Optional ¥
tab delimited file with 2 columns: name and sequence. For example: Illumina Small RNA RT Primer CAAGCAGAAGACGGCATACGA

cute

© Purpose Quote from FastQC

FastQC aims to provide a simple way to do some quality control checks on raw sequence data coming from high throughput sequencing pipelines. It provides a modular set of analyses which you
can use to give a quick impression of whether your data has any problems of which you should be aware before doing any further analysis.

The main functions of FastQC are:

Import of data from BAM, SAM or FastQ files (any variant)

Providing a quick overview to tell you in which areas there may be problems

Summary graphs and tables to quickly assess your data

Export of results to an HTML based permanent report

Offline operation to allow automated generation of reports without running the interactive application

FastQC is the best place to look for documentation - it's very good. Some features of the Galaxy wrapper you are using are described below.

O is Galaxy Tool You are using FastQC in Galaxy. This is easy because it has been packaged into a Galaxy tool by the Intergalactic Utilities Commission. It exposes the external package
FastQC which is documented at FastQC Kindly acknowledge it as well as this tool if you use it. FastQC incorporates the Picard-tools libraries for sam/bam processing.

The contaminants file parameter was borrowed from the independently developed fastqcwrapper contributed to the Galaxy Community Tool Shed by Jim Johnson.

(i ] Inputs and outputs

This wrapper will accept a Galaxy fastq, sam or bam as the input read file to check. It will also take an optional file containing a list of contaminants information, in the form of a tab-delimited
file with 2 columns, name and sequence.

FastQC produces a single HTML output file which is slightly adjusted so it looks good in Galaxy that contains all of the results, including the following:

Basic Statistics

Per base sequence quality
Per sequence quality scores
Per base sequence content
Per base GC content

Per sequence GC content
Per base N content
Sequence Length Distribution
Sequence Duplication Levels

History cn

Unnamed history

0 bytes 7=

O vour history is empty. Click 'Get
Data' on the left pane to start
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Analyzing Data: Next Generation Sequencing

Gal

Tools

Motif Tools

Multiple Alignments
Metagenomic analyses
FASTA manipulation

NGS: QC and manipulation

FastQC: Comprehensive QC
reporting for short read sequence

Barcode Splitter (ngs-tools)
Clip adapter sequences
ILLUMINA FASTQ

FASTQ Groomer convert between
various FASTQ quality formats

FASTQ splitter on joined paired
end reads

FASTQ joiner on paired end reads

FASTQ Summary Statistics by
column

ROCHE-454 DATA
Build base quality distribution
Select high guality segments

Combine FASTA and QUAL into
FASTQ

AB-SOLID DATA
Convert SOLID output to fastq

Compute guality statistics for
SOLID data

Draw guality score boxplot for
SOLID data
P —

FastQC: Comprehensive QC| version 0.53

Short read data from your current history:

Title for the output file - to remind you what the job was for:
|Fastac
Letters and numbers only please - other

Contaminant list:
Selection is Optional
tab delimited file with 2 columns: name a

© Purpose Quote from FastQC

FastQC aims to provide a simple way to do|
which you can use to give a quick impressif

put sequencing It p
re doing any further analysis.

The main functions of FastQC are:

Import of data from BAM, SAM or FastQ fil
Providing a quick overview to tell you in wi
Summary graphs and tables to quickly assess your
Export of results to an HTML based permanent r
Offline operation to allow automated genergs
FastQC is the best place to look for do

out running the interactive application
very good. Some features of the Galaxy wrapper you are using are described below.

0 This Galaxy Tool Yo! tQC in Galaxy. This is easy because it has been packaged into a Galaxy tool by the Intergalactic Utilities C

a

set of

the

| package

FastQC which is

puts and outputs

This wrapper will accept a Galaxy fastg, sam or bam as the input read file to check. It will also take an optional file containing a list of contaminants information, in the form of a

GENERIC FASTQ MANIPULATION

Filter FASTQ reads by quality score
and length

FASTQ Trimmer by column

FASTQ Quality Trimmer by sliding
window

FASTQ Masker by quality score

FASTQ interlacer on paired end
reads

FASTQ de-interlacer on paired end
reads

Manipulate FASTQ reads on
various attributes

FASTQ to FASTA converter
FASTQ to Tabular converter
Tabular to FASTQ converter

tab-delimited file with 2 columns, name and sequence.
FastQC produces a single HTML output file which is slightly adjusted so it looks good in Galaxy that contains all of the results, including the following:

Basic Statistics

Per base sequence quality
Per sequence quality scores
Per base sequence content
Per base GC content

Per sequence GC content
Per base N content
Sequence Length Distribution
Sequence Duplication Levels
Overrepresented sequences
Kmer Content

All except Basic istics and Overrep are plots.

arameter was borrowed from the independently developed fastqcwrapper contributed to the Galaxy Community Tool Shed by Jim Johnson.

at FastQC Kindly acknowledge it as well as this tool if you use it. FastQC incorporates the Picard-tools libraries for sam/bam processing.

History co

Unnamed history
0 bytes &L=

© Your history is empty. Click 'Get
Data’ on the left pane to start
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Analyzing Data:

® 00

Galaxy

Next Generation Sequencing

[4 | » ][i‘g http://main.gZ.bx.psu.edu/(oot

C ] .-:(.Q' Google

:_\._/

Workflow

Analyze Data

Data Libraries

Admin Help User

Tools

Statistics =]
Graph/Display Data

Regional Variation

Multiple regression

Multivariate Analysis

Evolution

Metagenomic analyses

EMBOSS

Map with BWA

NGS TOOLBOX BETA

NGS: QC and manipulation
NGS: Mappin
ILLUMINA

~Blood-PCR1 |+

BWA settings to use:
’ Commonly Used 4]

= Map with BWA

=294 < control use Full Parameter List

= Lastz map short reads against
reference sequence

= Megablast compare short reads
against htgs, nt, and wgs
databases

Execute
= Parse blast XML output
AB-SOLID
= Map with Bowtie for SOLID

NGS: SAM Tools
NGS: Peak Callin

What it does

Bioinformatics, 25, 1754-60.

Suppress the header in the output SAM file:

bry or use a built-in

Must have Sanger-scaled quality values with ASCII offset 33

For most mapping needs use Commonly Used settings. If you want full

BWA produces SAM with several lines of header information

BWA is a fast light-weighted tool that aligns relatively short sequences
(queries) to a sequence database (large), such as the human reference genome.
It is developed by Heng Li at the Sanger Insitute. Li H. and Durbin R. (2009)
Fast and accurate short read alignment with Burrows-Wheeler transform.

History Options «
OE PE il
Unnamed history

6: Boxplot on data 5 @ J R

19.1 Kb, format: png, database:
hgl9
Info:

o

Image in png format

5: FASTQ Summary @ R
Statistics on data 2
4: Boxplot on data 3 @ R

19.1 Kb, format: png, database:
hgl9
Info:

=

Image in png format

RGENETICS

SNP/WGA: Data; Filters
SNP/WGA: QC; LD; Plots
SNP/WGA: Statistical Models

Know what you are doing

[, -
L -

Workflows

There is no such thing (yet) as an automated gearshift in short read
mapping. It is all like stick-shift driving in San Francisco. In other words =
running this tool with default parameters will probably not give you
meaningful results. A way to deal with this is to understand the

ion and exnerimenting

3: FASTQ Summary @ R

Statistics on data 1

76 lines, 1 comments, format:
tabular, database: hgl9

Info: 502027 fastqg reads were
processed.

Based upon quality values and
sequence characters, the input
data is valid for: sanger

Input ASCII range: '#'(35) - 'C'(67)
Input decimal range: 2 - 34

= /

#column count  min max sum mes
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Analyzing Data: Next Generation Sequencing

Tools

search tools [x]

Get Data

Send Data

ENCODE Tools

Lift-Over

Text Manipulation

Filter and Sort

Join, Subtract and Group
Convert Formats

Extract Features

Fetch Sequences

Fetch Alignments

Get Genomic Scores
Operate on Genomic Intervals
Statistics

Wavelet Analysis
Graph/Display Data
Regional Variation
Multiple regression
Multivariate Analysis
Evolution

Motif Tools

Multiple Alignments
Metagenomic analyses
FASTA manipulation
NGS: QC and manipulation
NGS: Mapping

NGS: Indel Analysis

NGS: RNA AnaI‘sis
NGS: SAM Tools
BCF Tools Cat This tool allows the

user to concatenate BCF files.

beftools view Converts BCF format
to VCF format

BCF Tools Index This tool allows
the user to index sorted BCF for
random access.

MPileup SNP and indel caller

SAM-to-BAM converts SAM format
to BAM format

beftools view Converts BCF format
to VCF format

NGS: GATK Tools (beta)
NGS: Peak Calling

NGS: Simulation
SNP/WGA: Data; Filters
Phenotype Association
VCF Tools

N

History o -

MPileup (version 0.0.2)

Choose the source for the reference list: Unnamed history

Locally cached 0 bytes &=

BAM files © vour history is empty. Click 'Get
Data’ on the left pane to start
BAM file 1
BAM file:

Add new BAM file

Using reference genome:

~
v

Genotype Likelihood Computation:
Do not perform genotype likelihood computation

Set advanced options:

Basic <]

What it does

Generate BCF or pileup for one or multiple BAM files. Alignment records are grouped by sample identifiers in @RG header lines. If sample identifiers are absent, each input file is
regarded as one sample.

Settings:

Input Options:

-6 Assume the quality is in the Illumina 1.3+ encoding.

-A Do not skip anomalous read pairs in variant calling.

=B Disable probabilistic realignment for the computation of base alignment guality (BAQ). BAQ is the Phred-scaled probability of a read base being mis
-b FILE List of input BAM files, one file per line [null]

-C INT Coefficient for downgrading mapping quality for reads containing excessive mismatches. Given a read with a phred-scaled probability g of be
-d INT At a position, read maximally INT reads per input BAM. [250]

-E Extended BAQ computation. This option helps sensitivity especially for MNPs, but may hurt specificity a little bit.

-f FILE The faidx-indexed reference file in the FASTA format. The file can be optionally compressed by razip. [null]

-1 FILE BED or position list file containing a list of regions or sites where pileup or BCF should be generated [null]

-q INT Minimum mapping quality for an alignment to be used [0]

-Q INT Minimum base qguality for a base to be considered [13]

-r STR Only generate pileup in region STR [all sites]

Output Options:

=D Output per-sample read depth

-g Compute genotype likelihoods and output them in the binary call format (BCF).

-S Output per-sample Phred-scaled strand bias P-value

-u Similar to -g except that the output is uncompressed BCF, which is preferred for piping.

Options for Genotype Likelihood Computation (for -g or -u):

-e INT Phred-scaled gap extension sequencing error probability. Reducing INT leads to longer indels. [20]

-h INT Coefficient for modeling homopolymer errors. Given an l-long homopolymer run, the sequencing error of an indel of size s is modeled as INT*
-I Do not perform INDEL calling

-L INT Skip INDEL calling if the average per-sample depth is above INT. [250]

-0 INT Phred-scaled gap open sequencing error probability. Reducing INT leads to more indel calls. [40]

=P STR Comma dilimited list of platforms (determined by @RG-PL) from which indel candidates are obtained. It is recommended to collect indel candi

47



Analyzing Data: Next Generation Sequencing

Tools

search tools

Get Data

Send Data

ENCODE Tools
Lift-Over

Text Manipulation
Filter and Sort

Join, Subtract and Group
Convert Formats
Extract Features

Fetch Sequences

Fetch Alignments

Get Genomic Scores
Operate on Genomic Intervals
Statistics

Wavelet Analysis
Graph/Display Data
Regional Variation
Multiple regression
Multivariate Analysis
Evolution

Motif Tools

Multiple Alignments
Metagenomic analyses
FASTA manipulation
NGS: QC and manipulation
NGS: Mapping

NGS: Indel Analysis
NGS: RNA Analysis
NGS: SAM Tools

NGS: GATK Tools (beta)
NGS: Peak Calling

NGS: Simulation
SNP/WGA: Data; Filters
Phenotype Association
VCF Tools

Workflows

= All workflows

U G R Institute for Integrative
Genome Biology

Welcome to IIGB's Galaxy Server!

Overview

Galaxy is an open, highly customizable, web-based platform for the analysis of next generation sequence data and many other biological data types. It
enables users to run computationally demanding next generation sequencing analysis tasks on powerful server hardware from a graphical web
browser-based user interface rather than the Linux command-line. A subset of of application supported by Galaxy is given in the left pane. Much more
detailed descriptions of Galaxy's basic functionalities including user tutorials are available here.

Why Local Galaxy Service?

There are many advantages of using a local Galaxy server here at UCR rather than public test instances of Galaxy available on the internet. The most
important are: (1) shorter waiting queues for analysis tasks; (2) elimination of time consuming uploads of large data sets; (3) support for analyzing much
larger data sets than this is possible on public services; (4) the ability to customize software tools and database collections.

How to Gain Access?

This instance of Galaxy runs on lIGB's high performance compute (HPC) infrastructure, called Biocluster. As such its usage is covered by the annual
registration fee for this infrastructure (see here for details). Users with an active Biocluster account can access this Galaxy service using their existing user
name and password without any extra cost. New account requests for this service can be sent to support@biocluster.ucr.edu.

Additional Databases and Sofware Tools
Support requests for including additional reference genomes and software tools on IIGB's Galaxy server can be sent to support@biocluster.ucr.edu

Workshops on Galaxy
Past and future UCR workshop events on using Galaxy are listed here. The user manual from previous workshops can be accessed here.

Enter IIGB's Galaxy Service
To enter this service, click here.

History

Unnamed history
0 bytes ]

0 Your history is empty. Click 'Get
Data' on the left pane to start
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Analyzing Data: Next Generation Sequencing

Analyze Data

Using 0%

Tools

(b

0)

NGS: SAM Tools

BCF Tools Cat This tool allows the

user to concatenate BCF files.

beftools view Converts BCF format

to VCF format

BCF Tools Index This tool allows
the user to index sorted BCF for
random access.

beftools view Converts BCF format

to VCF format

Workflows
= All workflows

U C R Institute for Integrative
Genome Biology

Welcome to IIGB's Galaxy Server!

Overview

Galaxy is an open, highly customizable, web-based platform for the analysis of next generation sequence data and many other biological data types. It
enables users to run computationally demanding next generation sequencing analysis tasks on powerful server hardware from a graphical web
browser-based user interface rather than the Linux command-line. A subset of of application supported by Galaxy is given in the left pane. Much more
detailed descriptions of Galaxy's basic functionalities including user tutorials are available here.

Why Local Galaxy Service?

There are many advantages of using a local Galaxy server here at UCR rather than public test instances of Galaxy available on the internet. The most
important are: (1) shorter waiting queues for analysis tasks; (2) elimination of time consuming uploads of large data sets; (3) support for analyzing much
larger data sets than this is possible on public services; (4) the ability to customize software tools and database collections.

How to Gain Access?

This instance of Galaxy runs on IIGB's high performance compute (HPC) infrastructure, called Biocluster. As such its usage is covered by the annual
registration fee for this infrastructure (see here for details). Users with an active Biocluster account can access this Galaxy service using their existing user
name and password without any extra cost. New account requests for this service can be sent to support@biocluster.ucr.edu.

Additional Databases and Sofware Tools
Support requests for including additional reference genomes and software tools on IIGB's Galaxy server can be sent to support@biocluster.ucr.edu

Workshops on Galaxy
Past and future UCR workshop events on using Galaxy are listed here. The user manual from previous workshops can be accessed here.

Enter IIGB's Galaxy Service
To enter this service, click here.

History ce

Unnamed history
0 bytes %

ﬂ Your history is empty. Click 'Get
Data' on the left pane to start

49



NGS Analysis Using Galaxy

» Sequences and Alignment Format
» Galaxy overview and Interface
» Getting Data in Galaxy
» Analyzing Data in Galaxy
> Lift-Over
- Text manipulation tools
> Filter and Sort
- Operate on Genomic Intervals

> Quality Control
- Mapping Data

» History and workflow
» Galaxy Exercises
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History: History Options

Workflow Data Libraries Lab

Analyze Data

Tools chrX 38545128 38545628 istory Liste
Get Data ~ | chrX 38545601 38545674 i
mﬂ chrX 49530584 49531084 Saved Histories
send Data chrX 49530500 49531125 "
Shared Histories
ENCODE Tools chrX 53127786 53128286 El uc004drv.
Lift-Over chrx 53128065 53128441 83_2 500 Histories Shared with Me
chrX 70629024 70629524 - uc004dzz.1 1 >
' S|
Text Manipulation chrX 70629391 70629554 1012 500 Current History
Convert Formats chrX 100549346 100549846 . uc004ehm. 1 2 Create New
FASTA manipulation chrX 100549292 100549706 110_3 750 Clone
Filter and Sort chrX 100549346 100549846 + uc004ehn.1 2
ol Suhtiactand € chrX 100549292 100549706 110_3 750 Share
4oin, Subtract and Group chrx 118776103 118776603 + uc010ngl.1 1 —
Extract Features chrx 118776496 118776766 125_2 500 o arom
Fetch Sequences chrX 118889818 118890318 - uc004esb.1 1 Dataset Security
hrX 118889822 118889905 126_2 500
Fetch Alignments c i
chrX 134013887 134014387 - uc004eyf.1 1
Get Genomic Scores chrX 134013907 134014564 1443 750
Operate on Genomic Intervals chrX 134013798 134014298 - uc004eyg.2 2
= Intersect the intervals of two chrX 134013907 134014564 750 =T = =T ST
queries c:rx lgzgg:ggg 134306386 ucO04deyr. 49530584 49531084
chrX ik
= Subtract the intervals of two Shak 154147046 _5)3;::;:: iié::::j *
queries =
5 o A : 2 ::3 i::;:fg:g 100549346 100549846 +
= Mert e overlapping intervals
Jof o 9 g 154341170 100549346 100549846 +
( y Ta»
= Concatenate two queries into
one quei
quety. 7: ChrXGenes <= @ R
= Base Coverage of all intervals 2exons, upstream flanking
= Coverage of a set of intervals 436 regions, format: interval,
on second set of intervals database: hg18 :
Info: Location: Upstream, Region:
= Complement intervals of a whole, Flank-length: 500, Offset:
query 0
= Cluster the intervals of a query fna—;';l rerun | display at UCSC
= Join the intervals of two Spi e
queries side-by-side 1.Chrom 2.Start 3.Ew
chrX 157038 157538 + w
= Get flanks returns flanking chrX 719513 720013 + w
region/s for every gene chrX 1616000 1616500 — w
= Fetch closest feature for every ohrX: iiodadolilodascll- b
interval chrX 2429015 2429515 - e
hrX 2428580 2429080 -
= Profile Annotations for a set of ":) y <] :“
genomic intervals b k.
Statistics + r
T I 6: DnasHs on ChrX @R v




Workflow

tion Help  User

Tools Options v | | | Workflow Canvas | Workflow constructed from history 'Unnamed history' | Options v | | | Details
search tools | Tool: FASTQ Groomer |
Get Data Map with BWA % File to groom
ap wil
Send Data FASTQ Groomer Data input ‘input_file' (fastq)
ENCODE Tools Select a reference from
Lift-Over 2 File to groom history Input FASTQ quality scores type ¥
Text Manipulation output_file (fastqsanger, FASTQ file @
fastqcssanger, fastgsolexa, .
Convert For‘ma!s : fastgillumina) output (sam) Advanced Options
FASTA manipulation Hide Advanced Options B‘
Filter and Sort
join, Subtract and Group FASTQ Groomer X i
Extract Features Input dataset File to groom Select % SAM-to-BAM & | 2
1 A
Fetch Sequences output output_file (fastgsanger, Select lines from Convert SAM file [ Assign Columns
Fetch Alignments s - 4
: fastqcssanger, fastasolexa, it el Using reference fil output_file B
Get Genomic Scores fastallumina) l = Add actions to this step; actions are
R i :
Operate on Genomic Intervals outputl. (bam) applied when this workflow step
Statistics \Vf= | completes.
Graph/Display Data Input dataset Map with BWA % | Select X SAM-to-BAM % |
Regional Variation output | Select a reference from ) Select lines from Convert SAM file Edit Step Attributes
Multiple regression histo ) ) i :
i ; i out filel Using reference file Annotation / Notes:
Multivariate Analysis ) FASTQ file S
Evolution output] (bam)
Metagenomic analyses output {sam) J
Human Genome Variation Input dataset Map with BWA
Add an annotation or notes to this step;
EMBOSS annotations are available when a
NGS TOOLBOX BETA workflow is viewed.
NGS: QC and manipulation What it does
NGS: Mapping This tool offers several conversions options
NGS: SAM Tools relating to the FASTQ format.
NGS: Indel Analysis v o :
. = When using Basic options, the output will be
NGS: Peak Callin 7 sanger formatted or cssanger formatted (when
NGS: RNA Analysis the input is Color Space Sanger).
RGENETICS When converting, if a quality score falls
output (sam) 2 outside of the target score range, it will be
SNP/WGA: Data; Filters ) coerced to the closest available value (i.e. the
SNP/WGA: QC; LD: Plots minimum or maximum).
SNP/WGA: Statistical Models When converting between Solexa and the other 4
formats, quality scores are mapped between ¥
o | = s
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What’s next?

» Galaxy exercises
> SNP-Seq
- RNA-Seq

» Visualization
> IGV (Integrative Genomics Viewer)
o http://www.broadinstitute.org/igv/

Integrative 4 T .
Genomics = [
Viewer et H‘ ol

<5 l :
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